Microsoft Word Quick Reference Sheet

Crash Course: Microsoft Word

Microsoft Word is an incredibly powerful word processing program. Its features and
capabilities are extensive. Refer to this handout whenever you require quick reminders for the
best ways of maximizing Microsoft Word.

+ Special Characters

E Many fonts, such as Symbol or Wingdings, enable the printing of symbols and other
characters.

E To type special characters in Microsoft Word:

Select Insert on the Microsoft Word menu bar, and then click Symbol to open the
Symbol dialog box.

Insert symbols by selecting the appropriate font from the Font drop-down list,
highlighting the symbol you wish to insert, and clicking Insert.

B To insert special characters, click the Special Characters tab, highlight the
character you wish to insert, and click Insert.

B You can create keyboard shortcuts for frequently used symbols and characters. To
do so, highlight the symbol or special character you wish to create the shortcut key
combination for. Then click the Shortcut Key button, enter the shortcut key
combination to use, click Assign, and click Close.

+ Formatting Paragraphs

I Specify paragraph-level text formatting by clicking Format on the Word menu bar and
selecting Paragraph.

F The Indents and Spacing tab contains options for aligning the paragraph and
formatting outline level, indentation, and spacing. From this dialog box you can:

E Indent left and right margins.
E Create a hanging indent or create a special first-line indent.

B The Spacing option allows you to specify additional space before and after a
paragraph, while the Line Spacing drop-down box allows you to set paragraph line
spacing (such as double-spacing).

E The Line and Page Breaks tab controls text flow. The Pagination section of the dialog
box contains several options for specifying how text flows from page to page.

E Check the Window/Orphan Control box to prevent the first line of a paragraph from
becoming the last line on the previous page.

I Check the Keep lines together box to keep a paragraph, or number of paragraphs,
on the same page.

B Check the Keep with next box to keep headings and their subsequent paragraphs
on the same page.

E Check the Page break before box to create a page break before the paragraph so
it always starts at the top of a page.

I Check the Suppress line numbers box to omit line numbers for a specific number of
lines.

B Check the Don’t hyphenate box to turn off hyphenation within the selected text.
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I Using the Tabs button, available on either tab, you can customize tab settings,
including the distance between tabs and tab alignment.

+ Formatting Lists
E Word’s automated list feature makes creating lists short work.
To create a numbered list:

Simply type a line that begins with the numeral 1 followed by a period, a space,
and your text, and then press Enter.

Word will turn the text into the first line of a numbered list.

All subsequent lines containing text will be added to the numbered list with a new
number each time you press Enter.

To end a numbered list, just press Enter twice.

= To create a bulleted list:

Type an asterisk at the beginning of a line followed by your text, then press Enter.
Word will turn the line into the first line of a bulleted list.

All subsequent lines of text will be added to the bulleted list until you press Enter
twice.

When working with bulleted and numbered lists, create subcategories or subtopics by
pressing the Tab button at the beginning of a fresh line.

F Subsequently, you may exit subcategory or subtopic formatting and return to regular
category or number formatting by pressing the Shift and Tab keys simultaneously.

E Modify numbered and bulleted lists, and select different bullet and numbering styles,
by clicking Format, selecting Bullets and Numbering, and specifying the style you wish
to use.

E From the Bullets and Numbering dialog box, you can also specify outline symbols and
indentations as well as different list styles.

#+ Using Styles

E A style is a collection of stylistic information, such as text and paragraph formatting
values, associated with a character, text passage, or even an entire document.

I Styles enable the quick creation of consistent formats, including font type and
attributes (such as bold and/or italic treatment) and specific paragraph formatting and
spacing, via a single click.

I Specific styles have their own names, such as Normal or Heading 1. You may wish to
use one style for a section heading, another style for sub-headings, and a third style
for text.

B Word supports two style types:

B Paragraph styles contain formatting information applied to an entire paragraph.
Paragraph styles also contain character formatting information, such as font name,
font size, and color.

I Character styles specify formatting that is applied only to selected characters within
a paragraph, and they override Paragraph style settings. Characters within a
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paragraph can have their own style even when a paragraph style is applied to the
entire paragraph.

E To apply a style:
I Position the cursor where the style should begin.

Select the style you wish to use (by clicking Format on the menu bar and selecting
Styles and Formatting from the drop-down menu).

If you are editing an existing document, highlight portions of the text you wish to
apply the style to and specify the style. If you are creating the document, select the
style you wish to use and begin typing.

+ Using Templates
E Every Word document is based on a template.
All template files have a .dot file extension.

E A template is a Word document that contains preset styles, formatting, layout settings,
and other elements. For example, Word’s default Normal.dot template specifies top
and bottom margins of one inch and sets the font as twelve-point Times New Roman,
among other settings.

When you create a new document, Microsoft Word uses settings from its default global
template, namely Normal.dot.

You can create documents based on customized templates.
F  Word makes use of two types of templates:

B Global templates, including the default Normal template, contain settings that are
used by all documents. For example, the styles on the Style menu are part of the
Normal global template. The same is true of all of the default settings Word uses
when you create a new document without specifying another template.

Document templates contain settings that are used only for specific documents
created using a specialized template. The fax and letter templates included with
Word are examples of specialized document templates.

To apply a template in Microsoft Word:
B Click Tools on the menu bar.
B Select Templates and Add-Ins.

E In the Global Templates and Add-Ins window, highlight the template you wish to
use.

E Click OK.

F You can load templates by clicking the Add button, browsing to the .dot file you wish to
use, and clicking OK.

+ Using Themes

F Like a template, a theme contains formatting elements used to apply a specialized
look and feel to a document.

E Elements such as backgrounds, styles, bullets, borders, horizontal lines, and hyperlink
colors are all contained within a theme.
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F Unlike templates, themes don’t support custom toolbars, macros, menu settings, or
shortcut keys.

B Themes are best used when you need to quickly create a formatted document. They
provide stock design options that can be quickly applied to a document to give it a
professional appearance.

If you require a customized design, you will probably be better served creating a
unique template.

To apply a theme to a Word document:

Select Format on the menu bar.

Click Theme.

From the resulting Theme dialog box, select the theme you wish to apply.
Click OK.

You can customize existing themes slightly by choosing to select or deselect the Vivid
Colors, Active Graphics, and Background Image checkboxes. As you select or
deselect each, the Sample window updates to demonstrate the change selected.

#+ Using Tables

E The Table menu in Word provides a wide variety of features that allow you to organize
and format data.

E Although Word tables are sometimes thought to be complicated, in reality they can be
simple to use.

F To work with tables, select Table from the menu bar.

The Insert Table dialog box — called by clicking Table | Insert | Table — presents a
number of options, including the ability to specify the number of rows and columns as
well as settings to automatically fit data into a table.

The Table menu provides a number of formatting options that allow you to modify
existing tables.

E Basic tasks, such as adding or deleting rows, are performed by highlighting the
relevant location within a table and then selecting the command you wish to
execute from the Table menu, such as Split Cell, Insert Column, or Merge Cells.

B The same commands, and other table formatting options, can also be configured
from the pop-up menu that appears when you right-click highlighted areas within
the table.

E Most Table options are self-explanatory, such as Sort, which enables you to sort data
alphabetically, by date, or by number.

E Convert enables you to convert preexisting data into a table or convert table data to
plain text.

+ Creating Diagrams

F You can create and insert diagrams in Word documents by using the Drawing toolbar,
which you access by clicking View | Toolbars | Drawing.

E To create a diagram:
E Click View | Toolbars | Drawing.
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B Click the Insert Diagram or Organization Chart button. Alternatively, you can click
Insert | Diagram. Both actions open the Diagram Gallery dialog box.

E The Diagram Gallery box will appear and present you with six diagram options:
Organization Chart, Venn Diagram, Cycle Diagram, Pyramid Diagram, Target
Diagram, and Radial Diagram.

e Organization Charts show the organizational hierarchy within a company,
division, or group.

¢ Venn Diagrams show overlapping areas between and among various
elements.

e Cycle Diagrams illustrate processes with a continuous cycle.

¢ Pyramid Diagrams show foundation-based relationships.

e Target Diagrams show completed goal steps.

¢ Radial Diagrams show the relationships of various elements to a core element.
Once you make your selection, the default version of that diagram appears.

Click on each relevant section to customize the diagram with your information.

The entire diagram, of course, can be resized by clicking any of the circle icons that
appear on the diagram’s border and dragging the circle inward to make the
diagram smaller or outward to make it larger.

+ Inserting Charts and Excel Data

F Long lists of numbers are boring; they don’t arrest attention.
Graphs and charts are much more stimulating.
Use the Microsoft Graph application to insert a chart in a document.
B Click Insert, select Picture, and then click Chart.

E This feature allows you to create sophisticated charts by simply entering the
headings and data you wish to illustrate.

E The program will open a sample datasheet with basic values already provided as
placeholders, including column headings and sample data.

B As you reenter the datasheet values, the appropriate cells of the graph change to
reflect your data.

E If you've ever worked with Microsoft Excel, the Microsoft Graph feature will look very
much like a spreadsheet. In fact, if you already have data in an Excel spreadsheet,
you can easily cut and paste that information into the sample Microsoft Graph
datasheet.

4+ Track Changes and Comments

E Microsoft Word’s Track Changes feature allows multiple people to collaborate on a
single document while also tracking each person’s revisions.

E  With Track Changes enabled, Word marks each contributor’s edits with colored text.
F Enable Track Changes by clicking Tools and selecting Track Changes.

E Once edits are made, when the cursor subsequently highlights a marked change, a
ScreenTip pop-up displays the author and information for that edit.
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I Use the Reviewing toolbar to view proposed changes and edits in a document.

B Display Track Changes information by clicking View, selecting Toolbars, and
selecting the Reviewing toolbar (and being sure the drop-down box is set to
Original Showing Markup).

E You can also add comments to a document.

E The Comments feature allows you to annotate a document with notes that are not
part of the actual document. For example, an editor may wish to add comments
suggesting additions, deletions or changes.

* Such collaboration can also be used by a supervisor when reviewing a
subordinate’s document.

B To insert a Comment, click the Insert Comments icon on the Review toolbar or click
Insert and select Comments.

F To finalize a document, proposed changes must be accepted or rejected.

B You can choose to accept or reject each proposed change individually, or you can
accept or reject all changes at once.

E To accept or reject changes, use the Reviewing toolbar’s appropriate icons (mouse
over each icon for its description).

E Once a document is finished, select Final Showing Markup from the Reviewing
toolbar to ensure changes were made as intended.

+ Creating Forms

F Forms provide a structured set of fields for collecting information in a consistent and
organized manner.

F Forms can be created for expense reports, invoices, contact information, or mileage
reports.

Word forms can be used to create both paper and electronic documents.

F Use the Forms toolbar to create forms by clicking View, clicking Toolbars, and
selecting Forms.

B Buttons are provided for such form elements as check boxes, text-form fields, and
drop-down menus, as well as tables, which form the basis of many forms.

F Form fields are specially configured elements available only within the context of a
Word form.

B These fields allow you to specify the type information that can be entered, such as
only numbers, text, or dates.

B Form field functionality differentiates a form from a plain document and simplifies
customization.

I Specialized help information can be added to form fields to provide users with
directions on completing that field.

B To add customized Help information to a supported field, right-click the field and
select Properties from the pop-up menu. Next, click the Add Help Text button,
select the Type Your Own radio button and enter your help information. Click OK to
finish.

B Help information can also be displayed on the status bar or by pressing the F1 key,
or both.
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F Once you've created your form, it's a good idea to protect it from unwanted
modification by clicking the Protect Form icon on the Form toolbar, which locks your
form to prevent changes.

+ Creating Form Letters

E Use Microsoft Word’s Letter Wizard to create professional looking form letters in just
minutes.

F To create a form letter:

Click Tools from the menu bar.
Select Letters and Mailings.
Click Letter Wizard.

Within the Letter Format tab, specify the letter's page design and style using the
dialog boxes provided.

Click the Recipient Info tab and specify the recipient’s name and address, as well
as a salutation.

Click the Other Elements tab to specify such elements as a reference line, mailing
instructions, or the letter’s subject.

Click the Sender Info tab to enter information about the sender, select an
appropriate closing, and specify the number of enclosures.

E Click OK.

B The Letter Wizard will create the form letter, which can be further customized
should you require any additional changes.

Mail Merge allows you to prepare and send form letters to multiple customers,
employees, or other groups. Mail Merge can also be used to create mailing labels and
other types of documents that merge static information with other dynamic types of
data.

+ Performing Mail Merges

F Mail Merge automatically combines a document’s text with names, addresses, and
other information from an existing file to create form letters, mailing labels, and other
mass-mail documents.

F Mail Merge works by reading information from a data source and placing the values it
finds into specified fields within a Word document.

I The first step in creating a mail merge is to create a main document, such as a
form letter. Begin by clicking Tools, selecting Letters and Mailings, and clicking Malil
Merge.

B You'll be prompted to select the document type. For this example, we need to
select Letters, although other options include e-mail messages, envelopes, and
labels.

E Next, you must specify whether to use the current document, start from a template,
or start from an existing document.

B The next step is to select recipients. Options include using an existing list or
selecting from Outlook contacts.
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B The Mail Merge Wizard next prompts you to write your letter and provides address
block, greeting, postage, and other assistants.

B The wizard then lets you preview your letter.

B The final step is to complete the wizard by specifying whether the wizard should
print the letters or render an editable view.

Different versions of Microsoft Word feature slightly different takes on the powerful,
and highly customizable, Mail Merge feature.

e |f you spend some time working with the Mail Merge Wizard, you'll find it boasts
many options, but should you still have questions, contact the IT department.

+ Creating and Printing Labels

The Envelopes and Labels dialog box — accessed by clicking Tools | Letters and
Mailings | Envelopes and Labels — allows you to easily create printed envelopes and
mailing labels.

The Envelopes tab allows you to enter address information for a single envelope.

E If you conduct mass mailings, it's often easier to create a mailing labels document that
can be reused for future mailings.

Using the Labels tab, you can format text and other information for printing on either a
single label or a separate document consisting entirely of labels.

E Click the Labels tab to create labels.

B Next, specify the type of labels by clicking the Options button. Select the product
number for the labels to be used. This information is usually printed on the actual
label packaging.

E When preparing mass-mail efforts, you’ll want to create a separate document.

& Click the New Document button, and a new document appears that’s formatted for
the type of label you specified.

B Next, enter the addressing or other information into the new document.

e Should you have numerous addresses, you may wish to use the Mail Merge
feature (by clicking Tools | Letters and Mailings | Mail Merge).

e Select Labels.

e The wizard will walk you through the process of importing data from another
source to the labels document you specify. If you’re creating only a single label,
just type the information into the Address field.

E Once the labels are ready to print, be sure the printer is stocked with the actual blank
labels and click Print.

#+ Creating Tables of Contents
F Microsoft Word can automate the creation of tables of contents.

F Word bases table of contents entries on heading styles, such as Heading 1 and
Heading 2, which are part of every Word document based on the Normal.dot template.

F To create a table of contents:
B Position the cursor where you wish to create the table of contents.
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Click Insert.
Select Reference.
Click Index and Tables.

Select the Table of Contents tab and configure the format, style, and heading
levels you want to use.

Once you click OK, Word generates the table of contents by matching your
selections against what it finds in the document.

If you modify the document after creating the table of contents, be sure to highlight the
table of contents and press F9 to ensure that the updates are reflected.

+ Using Macros

F Everything you do in Microsoft Word can be recorded in a macro, a program that
captures a task or set of tasks in a single action.

E For example, pressing Ctrl-S executes a predefined macro for saving the current
document.

F Word gives you the ability to create your own macros and assign them to a toolbar
button or a keyboard shortcut.

To create a macro:

Click the Tools menu.

Select Macro.

Click Record New Macro. The Record Macro dialog box will appear.

Provide a name for your macro, specify whether the macro should be assigned to
the toolbar or keyboard shortcut, note the location where the macro should be
stored, and provide a description. Then click OK.

Next you’ll be prompted to customize the button’s location on a specific toolbar or
specify the keyboard combination to use.

B Then enter the tasks you wish the macro to perform.

B When finished, select Tools | Macro and click Stop Recording, or click the Stop
Recording button on the Stop Recording toolbar.

E Macros offer unlimited potential. Everything from simple tasks to complex operations
can be recorded in a single macro, so be sure to spend some time familiarizing
yourself with the feature if you find yourself performing many of the same actions
repeatedly.

+ New Features

F Newer versions of Microsoft Word, beginning with Office 2003, include powerful new
features.

B Many of the new features are designed to make it easier for workgroups to
collaborate on shared documents.

B Documents can now be saved to shared workspaces to give team members
access to the latest document version, reserve documents for editing, and work
with task lists and member lists.

E Another new feature introduced with Word 2003 is the Research pane.
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B Accessed from the Tools menu, the Research task pane enables you to search
multiple sources, such as the Encarta Dictionary, Thesaurus, and Encyclopedia,
from within a Word document.

E The Research pane can even be used to conduct Internet searches and insert
current stock prices and customized information.

F A new Reading Layout Toolbar — accessed by clicking View, selecting Toolbars, and
clicking Reading Layout — makes it easier to review and format documents.

B Among the options available from the Reading Layout toolbar are simple icons for
viewing a Document Map, creating thumbnail views of each page, increasing or
decreasing font size en masse, and making pages fit the screen without requiring
scrolling.
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Common Microsoft Word Keyboard Shortcuts

Shortcut Function
Ctrl+1 Single-space lines.
Ctrl+2 Double-space lines.
Ctrl+5 Set 1.5 line spacing.
Ctrl+A Select all of the information in the document.
Ctrl+B Apply bold formatting to the selected text.
Ctri+C Copy the selected information to the clipboard.
Ctrl+E Center a paragraph.
Ctrl+F Open the Find dialog box.
Ctrl+l Apply italic formatting to the selected text.
Ctrl+J Justify a paragraph.
Ctrl+L Left-align a paragraph.
Ctri+N Create a new document.
Ctri+0 Open a document.
Ctrl+P Print the current document.
Ctrl+R Right-align a paragraph.
Ctrl+S Save a document.
Ctrl+U Apply underline formatting to the selected text.
Ctrl+Vv Paste clipboard contents into the document.
Ctri+Ww Close a document or exit Word if no document is open.
Ctri+X Cut the selected information from the document.
Ctrl+Y Redo or repeat an action.
Ctrl+Z Undo an action.
Ctrl+Shift+A Format all letters in uppercase.
Ctrl+Shift+K Format all letters in lowercase.
Ctrl+Enter Insert a page break.
Ctrl+Shift+Enter Insert a column break.
Ctrl+Shift+E Turn revision marks on or off.
F1 Open Help or the Office Assistant.
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